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•	 All rights reserved, including those to reproduce this manual or parts 
thereof in any form without permission from Shimadzu Corporation. 

•	 The information in this manual is subject to change without notice and does 
not represent a commitment on the part of the vendor.

•	 Any errors or omissions which may have occurred in this manual despite 
the utmost care taken in its production will be corrected as soon as 
possible, although not necessarily immediately after detection.

•	 Maintenance parts for this product are provided for seven years after 
production has stopped. Please note that we may not be able to provide 
maintenance parts after this period. However, for parts that are not genuine 
Shimadzu parts, the period of provision is determined by the manufacturer.

•	 The contents of the hard disk in a PC can be lost due to an accident. 
Backup your hard disk to protect your important data from accidents.

•	 If the user or usage location changes, ensure that this Instruction Manual is 
always kept together with the product.

©2010-2017 Shimadzu Corporation. All rights reserved.

NOTICES
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Types of Manuals
Five Instruction Manuals are provided with LabSolutions.
You can also display the [Help] menu to confirm the meanings 
and setting ranges of parameters. 
The following shows how to make full use of the manuals.

��Getting Started Guide
This manual is for first-time users.
Follow the sequence of procedures in this guide to gain 
an understanding of basic LabSolutions operations.

��Operators Guide
This manual gives comprehensive 
information about overall 
data acquisition operations in 
LabSolutions, such as system 
configuration, data analysis, batch 
processing, and report functions.

��System Users Guide
This manual is for system 
administrators. 
This manual describes system 
administration and data 
management.

��Data Acquisition & 
Processing Theory Guide
This manual describes peak 
detection and quantitation of sample 
components (for advanced users).

�� Installation & 
Maintenance Guide
This manual describes installation 
and maintenance of the LabSolutions 
software.

��Help
Refer to [Help] to learn more about 
the displayed sub-window. 
Click the on-screen [Help] button 
or the [F1] key on the keyboard to 
display [Help]. 

The meanings of symbols used in this manual are 
as follows.

b
Useful advice for convenient 
instrument operation

B
Shows where to refer to in the 
Operators Guide
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What LabSolutions Can Do
LabSolutions software is very easy to use, while incorporating high-grade functions.
It provides powerful support for automating and improving the efficiency of sequential 
data acquisition and analysis operations.
Use LabSolutions to perform the following functions.

•	 Control of analytical instruments and data acquisition
•	 Data analysis and viewing of data
•	 Creation and printing of various customizable reports
•	 Data management

System Structure
This Getting Started Guide describes data acquisition operations with the assumption 
that the system includes the following instruments.

Gas Chromatograph GC-2030 / GC-2010
•	Autosampler AOC-20i

•	Split/Splitless Injection unit (SPL)

•	Capillary column: Stabilwax 30 m × 0.32 mm I.D, 0.5 µm-thick film

•	Flame ionization detector (FID)
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File Types

Data file (.gcd)

This file contains all analysis results and acquisition information from the following files.

Method file (.gcm)

Acquisition conditions,  
analysis conditions,  
calibration curve information, 
and etc.

Batch file (.gcb)

This file is used for
continuous data acquisition
of sequential samples.

Report format file (.lsr)

This file is used to print
data acquisition results.
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-Checks Before Operation-

Data Acquisition Flow
Set up the data acquisition conditions to 
suit the component to be measured.

Before starting data acquisition, set up the data acquisition conditions on 
LabSolutions. 
For the data analysis operations described in this manual, set as follows:

Column oven temperature
50 °C (3 min retention)  → 150 °C (2 min retention) 
(temperature rise speed 10 °C/min)

Injection unit temperature 250 °C

Carrier gas He, linear velocity 40 cm/sec, linear velocity mode

Sample injection method Split method

Split ratio 1:25

Detector temperature 250 °C

Sample
Alcohol mixed samples, 100, 500 and 1000 ppm 
standard samples, and 2 unknown samples

When you have finished setting up the data acquisition 
conditions, 

start off by acquiring the data.

On LabSolutions, the operation of analysis samples one at a time is called 
"single run".

To evaluate the data acquisition conditions, change the data acquisition 
conditions, measure standard samples and unknown samples, and check 
the separation state of the target component. 

Perform data acquisition on other samples using the data acquisition 
conditions that provided the optimum separation state. 

B 3 Single Run P.27

STEP 1
Set Up the 
Conditions 

STEP 2
Data 

Acquisition
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Setting up the data acquisition conditions and 
optimizing the data processing parameters are 
important for obtaining better data acquisition results. 
This section describes the basic flow of data analysis.

Perform data acquisition on sequential 
samples together. 
Realtime batch is performed to measure sequential samples continuously 
when the data acquisition conditions have been fixed by performing a 
single run.

B 5 Realtime Batch P.35

B 6 Multiple Data Analysis P.44

Realtime 
Batch

STEP 4

Display the data files acquired using 
realtime batch in step 4 by specifying 
filtering conditions in the Data Manager.
The Data Manager can display PDF files created during data acquisition.

B 7 Data Management P.52

Data 
Management

STEP 5

Process the acquired data, and 
apply the analysis conditions.
Normally, multiple data is analyzed to determine peak integration 
conditions so that consistent results (e.g. repeatability of retention time 
and peak area, detection limits of target components, and linearity) can be 
acquired.

When the data analysis conditions have been fixed, quantitative calculation 
(i.e. investigation as to how much of the target component is contained 
in the sample) is performed on the unknown sample based on the data 
analysis results of the acquired standard sample.

To perform quantitation, a calibration curve must be made from the known 
concentrations and peak area values of the standard samples. This 
calibration curve is used to calculate the concentration of the unknown 
sample.

B 4 Data Analysis P.29

STEP 3
Analysis
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LabSolutions Main Window

[Data Acquisition] 
window

for acquiring data

[Realtime Batch] 
window

for realtime batch
processing

[Data Analysis] 
window

for analyzing data

[Quant Browser] 
window

for analyzing data
from multiple

samples

 LabSolutions Main Programs and Main Windows

[Realtime Analysis]  
program

[Browser] 
program

[Postrun Analysis] 
program

[Instruments]
The analytical instruments connected to the PC are 
displayed as icons.

Double-click  to start the [Realtime Analysis] program 

where data acquisition settings are set and data is acquired.

[Postrun]
Displays the icons for the [Postrun Analysis] program (data 
analysis), and the [Browser] program 
(chromatogram display and quantitative calculation of 
results).

[Manual]
Displays the icons for the various PDF manuals and Help 
menu provided with LabSolutions.

[Administration]
Displays the icons of the system administration programs 
for data management, setting security policies, user 
administration and the log browser.

[Project]
Displays the currently open project. Projects comprise instruments, 
users, data, and other relevant information. 

Click  to open the project selection window.
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 LabSolutions Windows

The following example describes the 
[Realtime Analysis] program window.

Title Bar
This bar displays the names of the current program, window, loaded file, and other information.

This bar displays the names of the current program, window, loaded file, and other information.

Menu Bar
This bar displays the current window and menus that are available based on the operating rights of the current user.

Toolbar
This bar displays icons of frequently used menu items and icons for operating analytical instruments.

1

Assistant Bar
This bar displays 
icons for frequently 
used data acquisition 
operations.

Data Explorer
This sub-window 
displays files for the 
selected project and 
instruments.

2
Window
In the [Realtime Analysis] program, [Data Acquisition], 
[Realtime Batch] and other windows are displayed as icons 
on the assistant bar.
In the [Postrun Analysis] program, [Data Analysis], 
[Calibration Curve], [Report Format] and other windows are 
displayed. Switch the windows by clicking the icons on the 
assistant bar. Instrument Monitor (right side of the window) 
check the acquisition conditions and connections.

3

Output Window
This window displays an operation history and error messages that occur.

4

2

1

3

4
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Continuous Data Acquisition of Sequential Samples:
Open the [Realtime Batch] window from the main window.

2
1

pMain Window

q[Realtime Batch] window

q[Realtime Analysis] program

B 5 Realtime Batch P.35

3

B 1 Start Up P.12

 How to Open Windows
Note that a project must be selected in order to open windows.

Set the Data Acquisition Parameters and Execute a Single Run:
Open the [Data Acquisition] window from the main window.

B 2 Set the Instrument Parameters P.20

B 3 Single Run P.27

pMain Window

q[Realtime Analysis] program

q[Data Acquisition] window

3

2
1
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3

4

[Data Analysis] windowu

2

1

pMain Window

Double
Click !

B 4 Data Analysis P.29

Data Analysis and Quantitative Calculations:
Open the [Data Analysis] window from the main window.

q[Postrun Analysis] program

4

Multiple Data Analysis and Quantitative Calculations:
Open the [Quant Browser] window from the main window.

B 6 Multiple Data Analysis P.44

2

1

pMain Window

Double
Click !

3

4

5

q[Browser] program

[Quant Browser] windowu
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1	 Supply gas to the GC.
Open the main valve of the carrier gas and other gases to supply gas to the GC. 

2	 Turn the GC and peripheral devices on. 

3	 Turn the PC and printer on. 

4	Double-click  on the desktop.

The [Login] sub-window opens.

Start Up
This chapter describes how to start up LabSolutions.

$$ �Refer to "GC Data Acquisition" in Operators Guide for details on the "Data Acquisition" 
window.

Chapter

1



13

1  Start Up

5	 Log in.

1

2

Enter "Admin".

6	 Select a project.
Upon initial startup, the project selection window is displayed after logging in. In this 
case, select the desired project. For subsequent startups, the [Realtime Analysis] 
program opens using the project selected when the previous session was closed.

1

2

B  Refer to "System Management" in the Operators Guide for details on creating users.

7	Open the [Realtime Analysis] program.

1
2

Continued on the following page

The [Select Project] window is 
also displayed when logging in 
for the first time using a newly 
created user.

DD �
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8	Open the [Data Acquisition] window.

DD �Click here if the [Main] assistant bar is not 
displayed.

9	Comfirm the status.

In a normal state, [Not Ready] or [Ready] is displayed 
for the status.
Follow the recommendations below if  
[Not Connected] is displayed.
•	 Ensure that the power is ON.
•	 Ensure that instruments are connected correctly.
•	 Ensure that the system configuration settings are 

correct.

B  [Re-Set the System Configuration] P.16 for 
details.
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1  Start Up

10	Start the GC.

1

2

This message sometimes 
is not displayed. 

Make sure that [Ready] is displayed 
for the status after the GC temperature 
and other preset values are reached. 
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LabSolutions

SUPPLEMENT
"I want to connect to the system."
"I want to change the system configuration."

In such cases

Re-Set the System Configuration.

1	Open the [System Configuration] sub-window.

DD �Click here if the [Main] assistant bar is not 
displayed.

The [System Configuration] sub-window opens.
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1  Start Up

2	Open the [Data Acquisition] window.

1

The [Instrument] sub-window opens.

2 3

Select the GC to use. Click 

4

5

Select [RS-232C] and [COM Port].

Click here to display each instrument 
currently connected to the GC at 
[Modules Used for Analysis] in the 
[System Configuration] sub-window. 

Continued on the following page
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3	Check that the system configuration is correct.

1

2

Double-click the unit, 
and set the properties 
of each unit. 

Click here to send the settings to the GC.
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1  Start Up

LabSolutions

SUPPLEMENT "I want to change to another project."
In such cases

Click [Select Project].

1

2

3

Click [OK] to change to the selected 
project. The name of the selected project is 
displayed.

Select the desired project.
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1	Open the [Data Acquisition] window.

This part is called control panel. The instrument 
status can be checked and the instrument 
parameters can be edited.

Switching Display Settings

In the [Display Settings of Instrument Parameter View] sub-window, you can select displaying 
either the control panel or the instrument parameter view.

In case of GC-2030, you can switch [View Mode] ([Instrument Monitor] or [Instrument  
Parameter]) on the [Control Panel].

DD �

Set the Instrument Parameters
The data acquisition method (instrument parameters) are saved to the method file after 
they have been set in [Control Panel] in the [Data Acquisition] window.
This chapter explains how to set the instrument parameters.

Chapter

2
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2  Set the Instrument Parameters

2	Click [Column] image on the [Control Panel].

Click here to open the [Column] tab 
of [Method Editor] window.

3	 Edit the time table for the column temperature program.

Rate Temperature Hold time

0 - 50.0 3.00

1 10.00 150.0 2.00

Continued on the following page
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4	Click other unit image and edit parameters.

1 3

2

FID
Temperature : 250 ºC

AOC-20i
Injection Volume: 1.0 μL

SPL
Temperature : 250 ºC

In case of GC-2030,  you can select unit from the explorer bar at the left side of 
[Method Editor]window

In case of GC-2010, you can select unit by clicking tab on the [Method editor]window.

DD �
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2  Set the Instrument Parameters

5	 Save the data acquisition conditions.

1

3

2

Enter "Tutorial_Method".

4

Click here to download the data 
acquisition conditions to the instrument.
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LabSolutions

SUPPLEMENT Baseline Check
By the baseline check, you can check whether or not noise and drift values on the 
baseline are within the preset time and at the threshold or below. 
Baseline check parameters are saved in the method file.

1	 Set [Baseline Check Parameters].

1

3
2

4

Set both [Noise] and [Drift] to  , and enter 
[Start], [End] and [Threshold].

In the [Baseline Check] sub-window, the noise calculation method can be changed, and the maximum delay 
time when the result of the baseline check is [Fail] within the preset time. B  Help for details.

DD �

2	 Perform the baseline check.

1

After measurement ends, the check results are displayed in [Baseline Check Results] sub-window and 
[Output Window].

[Output Window]

Baseline Check Results
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2  Set the Instrument Parameters

LabSolutions

SUPPLEMENT
Slope Test
By performing the Slope Test, the peak detection sensitivity (Slope value) of peak 
integration parameters can be automatically set from the status of the noise and 
drift appearing on the chromatogram before data acquisition. 
The slope value obtained by the slope test is effective when performing 
isothermal analysis. This section describes the Slope Test.

•	 Slope values refer to the numerical values for determining the peak start and end points.  
To be more precise, the peak start point is judged when a ascent slope exceeds the preset 
value, and, alternatively, the peak end point is judged when a descent slope falls below the 
preset value.

•	 Optimum Slope values can be obtained from the data by the Slope Test. 

DD �

1

This menu is displayed by right-clicking 
on [Chromatogram View].

To apply the measurement 
result to the peak integration 
parameters, click here.

To make preset values clearer, set a value rounded up to the 
nearest integer larger than the displayed slope value.

For example, set "200" for "195.218".  

DD �

The measurement result is 
displayed when the test ends.
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LabSolutions

SUPPLEMENT Default Folder and  
Change the Default Folder

1

This folder is the default 
folder.

Set this sub-window when changing 
the folder or creating a new folder.
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3  Single Run

1	Open the [Data Acquisition] window.

2	Open the [Single Run] sub-window.

The [Single Run] sub-window opens.

Continued on the following page

Single Run
This chapter describes the operation of measuring a standard sample once only (single 
run) using a saved method file "Tutorial_Method.gcm".
First, perform single run using a standard sample.

Chapter

3
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3	 Set the conditions for a single run.
In this example, set the conditions for pouring 100 ppm of alcohol mixed sample into 
vial No. 1 on the auto-sampler, and injecting that sample.

1

3

2

Enter "Test".

Vial# : 1

Click here to start the acquisition.

DD �Click here to cancel data 
acquisition midway.

The status changes 
to  when data 
acquisition ends.

DD �Data acquisition automatically ends 
when the [Stop Time] (15.00 min) set in 
the method file is exceeded.
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4  Data Analysis

1	Open the [Postrun Analysis] program.

1

2
3

4

Select the instrument.

2	Open the [Data Analysis] window.

DD �Click here if the [Main] assistant bar is not 
displayed.

The [Data Analysis] window opens.
Continued on the following page

Data Analysis
After single run ends, check the data to see if the peaks have been detected correctly.
This chapter describes how to change the peak integration conditions of the data 
file "Test.gcd" obtained by performing single run to optimize the peak integration 
parameters.

Chapter

4
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3	Display "Test.gcd".

Click  on the upper section of the Data 
Explorer and then double-click "Test.gcd".

$$ �Refer to "Data Analysis" chapter in Operators Guide for details on the "Data Analysis" window.
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4  Data Analysis

4	 Enter the peak integration parameters.

Width values refer to the minimum half-width value (height 1/2 width) of the peak to detect. 
Noise peaks are removed by optimizing the Width value. 
Determine the start and end points of the peak by the Slope value. 
The positions where the absolute values of the baseline slope become these values are the start and end 
points of the peak.

$$ �Refer to "Peak Integration Parameters" of the "Data Analysis" chapter in Operators Guide for 
details on the Peak Integration Parameters.

DD �

5 1

4
Width : 3 sec

Slope : 1000 uV/min

2

3

Click  to edit each 
parameter value.
Click  to perform 
processing on the data, and the 
processing results are displayed 
in [Chromatogram View] and 
[Results View - Peak Table].

Continued on the following page
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5	 Enter the quantitative parameters.

DD �Click  to enlarge the 
window.

•	 The [External Standard] method involves calculating concentrations 
from the peak area (height) of unknown samples using a calibration 
curve made based on a standard sample.

•	 At [# of Calib. Levels], set the number of concentration points for the 
standard sample required for creating the calibration curve.

•	 When creating calibration curves with the least squares method, set 
[X Axis of Calib. Curve] to [Conc.].

DD �

3

2

4

1

Quantitative Method : External Standard

# of Calib. Levels : 3

5
X Axis of Calib. Curve : Conc.

ZOOM 
UP
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4  Data Analysis

6	 Fill in the Compound Table.

•	 The result obtained by performing data acquisition is used for [Ret. Time]. 
•	 Selecting the [Ret. Time] cell, and clicking the peak in [Chromatogram View] automatically 

enters the retention time of that peak to the currently selected [Ret. Time] cell.	  
The retention time can be set by simply clicking the mouse.

DD �

1
3

Name Type Ret. Time Conc.(1) Conc.(2) Conc.(3)

1-Propylalcohol Target 5.754 100.000 500.000 1000.000

Isobutylalcohol Target 6.674 100.000 500.000 1000.000

Isoamylalcohol Target 8.705 100.000 500.000 1000.000

Click  to 
change the cell 
background color to 
yellow to fix the newly 
edited parameters.

2

ZOOM 
UP

$$ �Refer to "Compound Table Retention Times Using the Mouse" of the "Data Analysis" chapter in Operators 
Guide for details on setting retention times.

Continued on the following page
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7	 Save the processing results to a data file.

Click here to save the processing results 
to "test.gcd".

8	 Save the method file.

1

Click here to open the [Save Method As] 
sub-window.

4

5
6

Click here to save the new 
data processing parameters 
to "Tutorial_Method.gcm".

To use saved data processing parameters for other data, perform either of the following operations to save the 
new data processing parameters to the method file (in this example, "Tutorial_Method.gcm"). 
•	 Click [Save Data and Method File] on the [File] menu.

•	 Click  (Apply to Method) on the [Data Analysis] assistant bar (operation in step 8 above).

DD �

2

3

Select "Tutorial_Method.gcm".

Set to 
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5  Realtime Batch

1	Open the [Realtime Analysis] program.

1
2

2	Open the [Realtime Batch] window.
DD �Click here if the [Main] assistant bar is not 

displayed.

The [Realtime Batch] window opens.
Continued on the following page

Realtime Batch
To perform data acquisition continuously on multiple samples (realtime batch), a Batch 
Table must first be created. Batch Tables can be easily created by using the table easy 
setting feature of LabSolutions.

Chapter

5
	5.1	 Create a Batch Table

In the following example, create a Batch Table with standard samples set to 1st to 9th 
rows, and unknown samples set to the 10th and 11th rows.
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3	 Edit the Batch Table.

1

•	 In Batch Tables, you can set the sample information of each sample and output of reports.

$$ �Refer to "Edit Batch Tables" of the "Realtime Batch" chapter, "Edit Batch Tables" of the 
"Calibration Curves" chapter in Operators Guide for details on the editing batch tables.

•	 When performing cleanup, enter "-1" in [Vial#] if the autosampler is used.

DD �

2

3

Set [Standard] to .
Vial#	 :	 1 to 3 
Injection Volume	 :	 1 µL
Repetitions	 :	 3 
Data File	 :	 Tutorial_Std

Click here to create a 
Batch Table made up 
of 11 rows.

Set [Unknown] to .
Vial#	 :	 4 to 5 
Injection Volume	 :	 1 µL 
Data File	 :	 Tutorial_Unk

4

5

Select [New].
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5  Realtime Batch

4	Copy a cell.

3

4

5

Select here.

1
2

5	 Enter a numbered series.

3

4

5

2

Select here.

1

Continued on the following page
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6	Directly enter remaining items to the Batch Table to  

	 create the Batch Table shown below.

7	 Save the batch file.

3

2

Enter "Tutorial_Batch".

1
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5  Realtime Batch

LabSolutions

SUPPLEMENT Create Batch Table Using
Quick Batch
You can also create a Batch Table using quick batch.

1

2 3

4

5

Select a sample type 
and vials.

Enter the sample 
information.

Click here to add settings to a Batch Table. 
In this figure, a Batch Table for the standard 
sample (vial 1) and unknown samples (vial 
2-4) is created.

Start realtime batch.

$$ Refer to Helb for details on operations ando the applicable mobile.

When	[(Auto	Filename)]	is	displayed	in	the	[Data	File	Name]	field,	you	cannot	directly	enter	a	data	
file	name.	To	enter	a	data	file	name	directly,	click	[Settings]	in	the	[Quick	Batch]	sub-window.	
On the [Data File Name] tab page in the displayed 
[Settings]	sub-window,	clear	the	[Create	filenames	
automatically with] checkbox.

DD �
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	5.2	 Realtime Batch Processing
Execute realtime batch using the Batch Table you created.

1	 Place the samples in the autosampler.

Vial 1 (level 1) Alcohol mixed sample 	 100 ppm solution (standard solution)

Vial 2 (level 2) Alcohol mixed sample 	 500 ppm solution (standard solution)

Vial 3 (level 3) Alcohol mixed sample 	 1000 ppm solution (standard solution)

Vial 4 Liquor (unknown sample)

Vial 5 Whiskey (unknown sample)

2	 Start realtime batch processing.

1 Click here to open the [Realtime Batch] and [Data 
Acquisition] windows simultaneously, and starts 
data acquisition from the 1st row of the Batch Table.

Click here to cancel data acquisition midway. 
To edit the content of the Batch Table during 
realtime batch, click  to pause realtime batch.
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5  Realtime Batch

LabSolutions

SUPPLEMENT

Print a Summary Report

1	 Add items to display in the Batch Table.
1

DD �The order of display items in the 
Batch Table can be changed by 
clicking [Up] or [Down].

3

4

2

Click here to add [Summary Type] and 
[Summary Report Format File] to the 
items to display in the Batch Table.

2	 Set up the summary report.

4

Select "SummaryReport_4".

5

After setting the summary report at Row Number: 1 
to 3, set Row Number: 4 to 6, 7 to 9, and 10 and 11 
in the same way.
Repeat step 2  onwards in the same order.

DD �

1

2

3

6

Row Number : 1 to 3

Continued on the following page
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3	Check the output configuration of the summary report.

When you have finished the output configuration of the summary report, execute realtime batch to 
print the summary report.

$$ �Refer to "5.2 Realtime Batch Processing" P.40 for details on executing realtime batch.

 [Printout Example]

Standard samples



43

5  Realtime Batch

Unknown samples
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1	Open the [Browser] program.

1

2
3

4

Select the instrument.

2	Open the [Quant Browser] window.

Open the [Quant Browser] window.

Multiple Data Analysis
The LabSolutions [Browser] program is handy for checking the quantitative calculation 
results and chromatograms of multiple data. 
In the [Quant Browser] window of the [Browser] program, you can check multiple data, 
and change the data processing parameters of the currently displayed method file to 
modify calibration curves and perform postrun batch on multiple data.

$$ �Refer to "Quant Browser" chapter in Operators Guide for details on the "Quant Browser" 
window.

Chapter

6
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6  Multiple Data Analysis

3	 Load the batch file.

2

1

Drag and drop this file to display the 
quantitative results data.

Continued on the following page
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4	Confirm quantitative results.
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6  Multiple Data Analysis

LabSolutions

SUPPLEMENT

Modify Calibration Curves

1	Confirm peak integration parameters.
Confirm the peak integration parameters when peak detection is inappropriate.

2

Make sure that these 
values are appropriate.

13

ZOOM 
UP

Click here to perform 
postrun batch on all data.

Continued on the following page
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2	Confirm identification parameters.
Confirm the identification parameters and Compound Table when peaks are not identified correctly.

2
3

Make sure that these 
values are appropriate.

1

ZOOM 
UP

4

3	Confirm the Compound Table.

2

3
Make sure that these 
values are appropriate.

1

ZOOM 
UP

4
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6  Multiple Data Analysis

4	Confirm calibration points.

2

Confirm the calibration curve.

1

Make sure that the 
calibration point on the 
1st row is set to .

ZOOM 
UP

5	 Save the method file and data file.
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LabSolutions

SUPPLEMENT Export Quantitative Calculation Results
This section describes how to save quantitative calculation results as a text file.

1

4

2

3

5

Click here to save the "QuantResult.txt" 
file in the Sample folder.

Select [Output File], and 
enter "QuantitativeResult" 
as the file name.

Select [Items Displayed on 
the Screen].

Select [All IDs].

$$ �Refer to "Export the Quantitative Results" of the "Quant Browser" chapter in Operators Guide for details on 
exporting quantitative results.
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6  Multiple Data Analysis

LabSolutions

SUPPLEMENT Print the Quantitative Results Table
To print a browser report, select [Print] at [Print Table] on the [File] menu.

Select [Edit Format] from 
[Print Table] on the [File] 
menu to edit the report 
format. 

DD �
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1	Open the [DataManager] program.

1

2

2	 Select [Data] for [Files of type].

The Data Manager can be used to view information on methods, batches, and report format 
files.
To view such information, clicking on [Show Method/Batch/Report Format in Database] in the 
[Tools] menu allows you to select method, batch, or report for [Files of type].

DD �

Data Management
The [DataManager] program in LabSolutions provides a convenient way to filter and 
view the files used by LabSolutions, which include data files, method files, batch files, 
and report format files, by specifying filtering conditions, such as the instrument name.

$$ �Refer to the System Users Guide for details on the [DataManager] window.

Chapter

7
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7  Data Management

3	 Filter the data using the [Instrument Name] condition.

2

Enter "Instrument1" for [Instrument Name].

1

3

Continued on the following page
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4	Check the filtered data.

Check the filtered data file names.

5	Check the information of the selected data.

1

Click on "Tutorial_Std002.gcd".

Check the information contained in the data.

ZOOM 
UP
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7  Data Management

6	Display the PDF result file for the data file.

1

Click on "Tutorial_Std002.gcd".

Double-click on "  Tutorial_Std002.pdf *".2
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 PDF Result File

9/13/2010 6:53:16 PM Page 1 / 1

Sample_GC_EN - 0-1/0-7 - Tutorial_Std002.gcd

Analysis Report

Sample Name : Alcohol Mixture
Sample ID : Standard 100ppm
Data Filename : Tutorial_Std002.gcd
Method Filename : Tutorial_Method.gcm
Batch Filename : Tutorial_Batch.gcb
Vial # : 1-1 Sample Type : Standard
Injection Volume : 1 uL Level : 1
Date Acquired : 4/8/2009 11:39:26 PM Acquired by : System Administrator
Date Processed : 9/13/2010 6:53:14 PM Processed by : System Administrator

<Chromatogram>

min

uV

2.5 5.0 7.5 10.0 12.5

0

5000

10000

15000 FID1

4.
26

1

5.
75

1

6.
67

3

8.
70

4

9.
32

9

<Peak Table>
FID1
Peak#

1
2
3
4
5

Total

Ret. Time
4.261
5.751
6.673
8.704
9.329

Area
215182424

25804
32067
32338
1518

215274151

Height
20938578

10923
13194
14359

773
20977827

Conc.
0.000

104.131
103.501
103.827

0.000

Unit

ppm
ppm
ppm

Mark Name

1-Propylalcohol
 Isobutylalcohol
 Isoamylalcohol

<Sample Information>
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7  Data Management

LabSolutions

SUPPLEMENT Open the [Postrun Analysis] Program.
The procedure for opening the [Postrun Analysis] program from the Data Manager 
is described below.

1

Select "Tutorial_Std002.gcd", right-
click on the file name, and then click 
[Open with Related Application].

The [Postrun Analysis] 
program opens.
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1	 Stop the GC.

ShutDown
Last of all, this chapter describes how to exit LabSolutions.

Chapter

8
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8  ShutDown

2	 Select [Exit] when the oven has cooled down.

3	Click [Yes].

When there is a file that has not yet been saved, a window to 
confirm whether or not to save the file when exiting the [Realtime 
Analysis] program opens. 

DD �

Continued on the following page
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4	 Exit LabSolutions.
If the [Postrun Analysis] program or [Browser] program is open, click [Exit] on the [File] 
menu of each program to exit the respective program.

5	 Shutdown Windows, and turn the PC and printer off.

6	 Turn the GC and peripheral devices off.

7	Close the main valve of the carrier gas and other gases.
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